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 Overview of Database Configuration

Special Instructions for Configuring Databases
For your convenience this document pulls the information on database configuration out of the hp OpenView
Reporter Installation and Special Configuration Guide and includes it with your Internet Services product.

Overview

Internet Services and Reporter share the same database for storing performance and reporting information. The
default database for Internet Services 3.5 was MS Access.   The default database for Internet Services 4.0 is
MSDE.  You may choose to change the database to one of the following supported databases:

Oracle 8.0.6 for Solaris or HP-UX●   

Oracle 8.1.6/8.1.7 for Solaris or HP-UX●   

SQL Server 7 (if already set up with a previous version of OVIS) or 2000●   

There are several database configurations possible depending on which OpenView products you have installed.
See the following scenarios:

If you have Reporter already installed on the same
system as Internet Services is or will be installed.

When you install OVIS, it will detect whatever
database is configured for Reporter and use this
same database. The OVIS installation configures a
connection to this database and adds table entries
for OVIS as needed.

If you do not have Reporter and are installing
Internet Services for the first time.

The MSDE default database is installed. You can
later use instructions in this guide for configuring
an Oracle or SQL Server 2000 database instead.

If you do not have Reporter and are updating from
a previous version of Internet Services to version
4.0

The upgrade to OVIS 4.0 uses the existing
database, it could be MS Access, Oracle or SQL

If you do not have Reporter or OVIS on the system,
and for some reason you have SQL 7 installed on
the system but not configured for use with OVIS or
Reporter and install OVIS

The install will install MS Access as the default
database instead of MSDE.  This is because SQL 7
and MSDE are not compatible.

 

WARNING: Migration of data from your old database to the new database is not supported for Internet
Services.  And if you have OVIS and Reporter on the same system, attempting to migrate Reporter data to the
new database may result in problems in OVIS..

Using this guide

The information in this guide was taken from the Reporter documentation. The database configuration
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procedures are almost identical for Internet Services but since the document was created for Reporter you will
need to consider the following:

References to the Reporter product in this document apply to Internet Services also.

References to using the Reporter GUI to configure Oracle database logins are replaced with instructions for
using the Internet Services Configuration Manager to configure the Oracle database logins.

 

Overview of SQL and Oracle Database Configuration
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 UNIX Settings

This document applies to Oracle 8.0.6 and shows kernel parameter settings (Part I) for the default installation,
where you use the Oracle database, and settings for a custom database configuration (Part 2). For more
information on settings for Oracle 8.1.6/8.1.7 please refer to the Oracle 8i Installation Guide, chapter 2,
Pre-Installation. 

The topics are as follows:
Part 1: Setting Kernel Parameter Minimum Values■   

Part 2: For Oracle Database Setup on UNIX / Setting UNIX Environment Variables■   

Part 1: Setting Kernel Parameter Minimum Values
Kernel parameters setting for HP-UX and Solaris systems are outlined below.

HP-UX Systems

For your system to run more efficiently, modify (as necessary) the HP-UX kernel parameters to meet or exceed
the minimum values listed below. To modify kernel  values, run SAM and use the Kernel Parameters area to
change the specific parameters within the Action menu.

maxdsiz 32 MB
maxfiles 120
maxssiz 2 MB
maxuprc 100
nfile 3000
nproc 700
semmni 20
semmns 128
shmmax 64 MB
shmmni 100
shmseg 12

 IMPORTANT! To activate changes to settings, you must reboot your system.

Solaris Systems
For your system to run more efficiently, modify (as necessary) the Solaris shared memory parameters to meet or
exceed the minimum values listed below. To modify shared memory values, edit the /etc/system file and change
the specific parameters as listed below:

set shmsys:shminfo_shmmax=67108864
set shmsys:shminfo_shmmin=1
set shmsys:shminfo_shmmni=100
set shmsys:shminfo_shmseg=40
set semsys:seminfo_semmns=200
set semsys:seminfo_semmni=100

Section 2: UNIX Settings
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set semsys:seminfo_semmsl=30

 IMPORTANT! To activate changes to settings, you must reboot your system.

Part 2: For Oracle Database Setup on UNIX / Setting UNIX
Environment Variables

New Oracle Installations
You must be logged on as root or su1.  
Set UNIX environment variables as follows:

ORACLE_BASE – set to admin pathname default (/opt/oracle)
ORACLE_SID - set to the database name you want to create (reporter)
ORACLE_HOME - set to full pathname of the Oracle system home directory
$ORACLE_TERM – set to the appropriate value (hpterm, etc…)
PATH - needs to include $ORACLE_HOME/bin
UMASK = 022

2.  

Existing Oracle Installations

Verify that the following HP-UX environment variables are set:

ORACLE_BASE – set to admin pathname default (/opt/oracle)
ORACLE_SID - set to the database name you want to create (reporter)
ORACLE_HOME - set to full pathname of the Oracle system home directory
ORACLE_TERM – set to the appropriate value (hpterm, etc…)
PATH - needs to include $ORACLE_HOME/bin

Section 2: UNIX Settings
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 Set Up Microsoft SQL Server as the Database

Internet Services now uses MSDE (Microsoft Database Engine) as the database. (Previous
versions of Internet Services used MS Access as the default database.) The MSDE version
that is used is a subset of SQL Server 2000, which means that much of the SQL 2000
functionality is present in the MSDE database, even though no dialogs are available to assist
in the configuration. MSDE has a 2GB size limit per database instance. Knowing this, you may
at some point choose to change to a SQL Server 2000 database.

For this version of MSDE you will not be able to use the SQL Server 7.0 Enterprise Manager 
to look at the data in the MSDE database. The Internet Services data gets stored in an
instance of MSDE. The use of named instances is new for SQL Server 2000 and only a single
default instance is supported by SQL Server 7.0. To use the SQL Server 7.0 Enterprise
Manager, you would need to use an existing SQL 7.0 database.

 IMPORTANT: Do not run multiple copies of Internet Services as unexpected results occur
when more than one copy of Reporter attempts to write data to the configured database.

 IMPORTANT: Migration of data from your old database to the new SQL Server database
is not supported for Internet Services (OVIS).  And if OVIS is on the same system as hp
OpenView Reporter, attempting to migrate data to the new database with Reporter may result
in problems in OVIS.

The topics below cover configuration of both supported versions of SQL Server.
Part A: Configure Microsoft SQL Server 7.0 as the Reporter database.■   

Part B: Configure Microsoft SQL Server 2000 as the Reporter database.■   

Section 3: Configure SQL Server as the Database
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 Set Up Microsoft SQL as the Database
Part A: Configure SQL Server 7.0 

Set Up SQL Server 7 as the Database
To use Microsoft SQL Server as the database requires that you install and configure both server and client software. The first
section of this procedure covers server installation and configuration. The second covers both SQL client software installation,
and Internet Services configuration as an SQL Server account.

 IMPORTANT: You cannot go from the default MSDE database to SQL Server 7.0, use SQL Server 2000.

 IMPORTANT: Migration of data from your old database to the new SQL Server database is not supported for
Internet Services (OVIS). And if OVIS is on the same system as hp OpenView Reporter, attempting to migrate data
to the new database with Reporter may result in problems in OVIS.

The following is an overview of the configuration steps:

Configure the SQL Server system.
Task 1. Install SQL Server software.
Task 2. Verify the trust relationship between client and server.
Task 3. Configure the database on SQL Server.

Configure the SQL Client system.
Task 1. Install Internet Services.
Task 2. Install SQL Client software.
Task 3. Establish the ODBC connection.
Task 4. Configure Internet Services to use SQL as the database.
Final Task. Confirm that the database was set up.

Install & Configure SQL Server Software a Windows Server

If you have already installed SQL Server, you can skip Task #1. If your Internet Services system and the SQL Server system are
in the same domain, you can skip task Task #2 and go directly to Task #3.

Prerequisites include:  Windows NT 4.0, Service Pack 4 (or higher) or Windows 2000 ,and  Internet Explorer 5.01, Service
Pack 2 or higher

Task 1  Install SQL 7  Server Software

Insert the SQL Server 7.0  CD into the CD-ROM drive.1.  
Select Install SQL Server 7.0  Components.2.  
Select Database Server – Standard Edition.3.  
Select Local Install and respond to prompts as they appear.4.  
Be sure to select Mixed Mode for authentication.5.  
Restart the system.6.  

Task 2  Verify Trust Relationship Between Client and Server

Note: A trust relationship should be set up if the Reporter or Internet Services client and SQL Server are in separate domains
in NT4 or if the client and server run on mixed systems (Windows NT4 or Windows NT4 and Windows 2000). If the Internet
Services client and SQL Server are running on Windows 2000, skip this task.

Log on to the SQL Server-installed system with Administrator privileges. 1.  

Section 3, Part A: Configure SQL Server 7.0 
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From the Start menu select Programs>Administrative Tools>User Manager for Domains.2.  
From the Policies menu select Trust Relationships.3.  

In the Trusting Domains dialog box, look for the Domain where Internet Services is located. If the appropriate domain is
displayed, continue to the next task.
If not, add the trusting domains as needed. If you have questions about trusting domains, click the Help button (if Internet
Services and SQL Server systems are in separate domains, you must configure a trust relationship between the
systems).

4.  

Task 3  Configure the Database on SQL Server 7 

From the Start menu select Programs>Microsoft SQL Server 7.0>Enterprise Manager.1.  
In the Microsoft Console Root window, select your SQL Server Group.2.  
If your SQL Server system is not listed under the SQL Server Group, right-click SQL Server Group, select New SQL
Server Registration from the drop-down menu and follow the wizard online steps to register. 

3.  

Right-click Databases – New Database4.  
In General tab for the Name box, enter a name for the database (in the example, the name is Reporter).5.  

Section 3, Part A: Configure SQL Server 7.0 
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 Note: The SQL Server database no longer needs to be named Reporter.
In the Database files, Initial size (MB) column, enter 100.6.  
Click OK to close the window.7.  
After the database is created, expand Security.8.  
Right-click Logins – New Login...9.  
Select General Tab and in the Name box enter the user name openview or your specified user.10.  

Section 3, Part A: Configure SQL Server 7.0 
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Under Authentication select the SQL Server authentication radio button and enter your password.11.  
Under the Defaults, select Reporter from the Database list box.12.  
Select the Database Access tab and under Database access check the Permit box that corresponds to Reporter.13.  
Under Database roles for Reporter, check public and db_owner and select OK to exit.14.  

Section 3, Part A: Configure SQL Server 7.0 
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Confirm the new password from Step 11.15.  

To verify User has Database Access, in the left pane expand the security folder, or click the plus sign next to each item:
Security>Logins and you should see openview in the right pane.

16.  

Section 3, Part A: Configure SQL Server 7.0 
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Exit Enterprise Manager and go to the client system (where Reporter or Internet Services is installed).17.  

Install & Configure SQL Client Software

Installing SQL 7.0  Client includes three general areas:
Upgrade newer versions of Internet Services or the SQL database, or install Internet Services■   

Install SQL 7.0  software■   

Configure Internet Services ODBC connection■   

SQL 7.0 Client Installation Prerequisites
Internet Explorer 5.01 SP 2■   

500 MB Free Disk Space■   

SQL Server 7  CD■   

Product License – 10 digit code■   

Task 1  Upgrade or Install Internet Services           

Be sure that Internet Services is installed.1.  

Task 2  Install SQL Client Software

Important: This task is unnecessary if Internet Services and SQL Server are installed on the same system.
Insert the SQL Server 7  CD to install the SQL Client 7  software.1.  
Click autorun.exe.2.  
Click Install SQL Server 7.0  Components.3.  

Section 3, Part A: Configure SQL Server 7.0 
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Select Database Server – Standard Edition4.  
Follow the instructions as they appear.5.  
(NT4) Select Management Tools and Client Connectivity as the components to install; you can choose whether or not to
install documentation.
(Windows 2000) Select Server Components, Management Tools, and Client Connectivity as the components to install;
you can choose whether or not to install documentation.

6.  

Reboot the system after installation is complete7.  

Task 3  Establish the ODBC Connection

Important Note: Be sure that Internet Services is installed before beginning this step.  Also be sure that the 
Configuration Manager and Dashboard are closed before beginning this step.

Stop the following services:
HP Internet Services
Reporter Service
World Wide Web Pubshishing Service

1.  

On Windows NT 4.0: From the Start menu select Settings>Control Panel and double-click ODBC.
On Windows 2000: From the Start menu select Settings>Control Panel and doubel-click Administrative Tools.  Then
double-click Data Sources (ODBC).

2.  

In the ODBC Data Source Administrator window select the System DSN tab. Highlight Reporter and select the Remove
button.

3.  

Select the Add... button to create a new Reporter data source.4.  
In the Create New Data Source dialog box select the SQL Server driver and the Finish button.5.  

Section 3, Part A: Configure SQL Server 7.0 
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In the Create a New Data Source to SQL Server dialog, make sure that Reporter appears as the data source name box
and the server name appears in the Server box. Then select Next.

6.  

Select - With SQL Server authentication using a login ID and password entered by user.
Also check the box for Connect to SQL Server to obtain default settings. 
Enter the login ID and password that you used in the first section Install & Configure SQL Server 7 : Task 3  - Configure
the Database on SQL Server 7 .  Then select Next.

7.  

Section 3, Part A: Configure SQL Server 7.0 
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Check Change the default database to, select Reporter, and click Next.8.  

Check Perform translation for character data and select Finish.9.  

Section 3, Part A: Configure SQL Server 7.0 
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In the ODBC Microsoft SQL Server Setup dialog select the Test Data Source... button.10.  

Exit the SQL Server ODBC Data Source Test by clicking OK.11.  

Section 3, Part A: Configure SQL Server 7.0 
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Task 4  Configure Internet Services to use SQL as the Database

To start OpenView Internet Services Configuration Manager, select
Start>Programs>HP OpenView>internet services>Configuration Manager.

1.  

An error message is expected; click Yes to proceed.2.  
In the Database Login dialog box, enter the database User ID and Password that you used for the
system configuration.

3.  

Click OK.4.  
You will see the  Internet Services Startup status bars and then the main Configuration Manager window displays.5.  

Section 3, Part A: Configure SQL Server 7.0 
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Start the following services:
HP Internet Services
Reporter Service
World Wide Web Pubshishing Service

6.  

Final Task Confirm that the Database is Set Up

From the Start menu, select Programs>Microsoft SQL Server 7.0 >Query Analyzer.1.  
Connect to your SQL Server using SQL Server authentication using the user name and password you created.2.  
In the SQL Server Query Analyzer dialog, select DB: reporter.3.  
Enter a query to verify the database connection.4.  
Then you can check the setup of the  Internet Services probes by entering the query:
select PROBENAME from IOPS_PROBE_DEFINITIONS

5.  

Click the green arrow or press F5.6.  

An example of the results follows:7.  

Section 3, Part A: Configure SQL Server 7.0 
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 Set Up Microsoft SQL as the Database
Part B: Configure SQL Server 2000 

Set Up SQL Server 2000 as the Database
To use Microsoft SQL Server as the  Internet Services database requires both server and client software. The first section of this
procedure covers the SQL server software installation and configuration. The second section covers the SQL client  software
installation as well as Internet Services configuration as an SQL Server account.

Internet Services 4.0 uses the MSDE (Microsoft Database Engine) as its database. Previous versions of  Internet Services used
Microsoft Access. The MSDE version that is used is a subset of SQL Server 2000, which means that much of the SQL 2000
functionality is present in the MSDE database, even though no dialogs are available to assist in the configuration. MSDE has a
2GB size limit per database instance. Knowing this, you may at some point choose to change to an SQL Server 2000 database.

Since the Internet Services product does use an MSDE instance you will see the instance name when using SQL Server 2000
Enterprise Manager to look at an MSDE database. The corresponding SQL Server 2000 examples will not use the instance
name. You are not required to use an instance name when using SQL Server 2000. 

Note: IMPORTANT: Migration of data from your old database to the new SQL Server database is not supported for Internet
Services (OVIS). And if OVIS is on the same system as hp OpenView Reporter, attempting to migrate data to the new database
with Reporter may result in problems in OVIS.

The following is an overview of the configuration steps:

Configure the SQL Server system.
Task 1. Install SQL Server software.
Task 2. Verify the trust relationship between client and server.
Task 3. Configure the database on SQL Server.

Configure the SQL Client system.
Task 1. Install Internet Services.
Task 2. Install SQL Client software.
Task 3. Establish the ODBC connection.
Task 4. Configure Internet Services to use SQL as the database.
Final Task. Confirm that the database was set up.

Install & Configure SQL Server Software on Windows Server
If you have already installed SQL Server, you can skip Task #1. If your Internet Services system and the SQL Server system are
in the same domain, you can skip task Task #2 and go directly to Task #3.

Prerequisites include:  Windows NT 4.0, Service Pack 4 (or higher) or Windows 2000, and  Internet Explorer 5.01, Service
Pack 2 or higher

Task 1  Install SQL 2000 Server Software

Insert the SQL Server  2000 CD into the CD-ROM drive.1.  
Select Install SQL  2000 Components.2.  
Select Database Server – Standard Edition.3.  
Select Local Computer and respond to prompts as they appear.4.  
Be sure to use Mixed Mode for authentication.5.  
Restart the system.6.  

Task 2  Verify Trust Relationship Between Client and Server

Section 3, Part B: Configure SQL Server 2000 

file:///C|/FrontPage Webs/Content/hpovreports/Help/section03B.htm (1 of 14) [3/11/2002 12:33:19 PM]

file:///C|/FrontPage Webs/Content/hpovreports/Help/indxentries_install.htm


Note: A trust relationship should be set up if the Internet Services client and SQL Server are in separate domains in NT4 or if
the client and server run on mixed systems (Windows NT4 or Windows NT4 and Windows 2000). If the client and SQL Server
are running on Windows 2000, skip this task.

Log on to the SQL Server-installed system with Administrator privileges. 1.  
From the Start menu select Programs>Administrative Tools>User Manager for Domains.2.  
From the Policies menu select Trust Relationships.3.  

In the Trusting Domains dialog box, look for the Domain where Internet Services is located. If the appropriate domain is
displayed, continue to the next task.
If not, add the trusting domains as needed. If you have questions about trusting domains, click the Help button (if Internet
Services and SQL Server systems are in separate domains, you must configure a trust relationship between the
systems).

4.  

Task 3  Configure the Database on SQL Server  2000

From the Start menu select Programs>Microsoft SQL Server  2000 >Enterprise Manager.1.  
In the Microsoft Console Root window, select your SQL Server Group.2.  
If your SQL Server system is not listed under the SQL Server Group, right-click SQL Server Group, select New SQL
Server Registration from the drop-down menu and follow the wizard online steps to register. 

3.  

Right-click Databases – New Database 4.  
In the General tab for the Name box, enter a name for the database (example uses  Reporter as the name).5.  

Section 3, Part B: Configure SQL Server 2000 
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 Note: The SQL Server database no longer needs to be named Reporter.
Select the Data Files tab and in the Database files segment, in the Initial size (MB) column, enter 100.6.  
Click OK to close the window.7.  

Section 3, Part B: Configure SQL Server 2000 
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After the database is created, expand Security.8.  
Right-click Logins – New Login...9.  
Select General Tab and in the Name box enter the user name openview or your specified user.10.  

Section 3, Part B: Configure SQL Server 2000 
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Under Authentication select the SQL Server authentication radio button and enter your password.11.  
Under the Defaults, select Reporter from the Database list box.12.  
Select the Database Access tab and under Database access check the Permit box that corresponds to Reporter.13.  
Under Database roles for Reporter, check public and db_owner and select OK to exit.14.  

Section 3, Part B: Configure SQL Server 2000 
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Confirm the new password from Step 11.15.  

To verify User has Database Access, in the left pane expand the security folder, or click the plus sign next to each item:
Security>Logins and you should see openview in the right pane.

16.  

Section 3, Part B: Configure SQL Server 2000 
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Exit Enterprise Manager and go to the client system (where Internet Services is installed).17.  

Install & Configure SQL Client Software
Installing SQL 2000 Client includes three general areas:

Upgrade newer versions of Internet Services or the SQL database, or install Internet Services if not already installed■   

Configure Reporter ODBC connection■   

Install SQL 2000 software■   

SQL 2000 Client Installation Prerequisites
Internet Explorer 5.01 SP 2■   

500 MB Free Disk Space■   

SQL Server 2000 CD■   

Product License – 10 digit code■   

Task 1  Upgrade or Install Internet Services           

Install Internet Services.1.  

Task 2  Install SQL Client Software

Important: This task is unnecessary if  Internet Services and SQL Server are installed on the same system.
Insert the SQL Server  2000 CD to install the SQL Client 2000 software.1.  
Click autorun.exe.2.  
Click Install SQL  2000 Components.3.  

Section 3, Part B: Configure SQL Server 2000 
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Select Install Database Server 4.  
Follow the instructions as they appear.5.  
(NT4) Select Management Tools and Client Connectivity as the components to install; you can choose whether or not to
install documentation.
(Windows 2000) Select Server Components, Management Tools, and Client Connectivity as the components to install,
you can choose whether or not to install documentation.
 

6.  

Reboot the system after installation is complete7.  

Task 3  Establish the ODBC Connection

Important Note: Be sure that Internet Services is installed before beginning this step.  Also be sure that the 
Configuration Manager is closed before beginning this step.

Stop the following services:
HP Internet Services
Reporter Service
World Wide Web Pubshishing Service

1.  

On Windows NT 4.0: From the Start menu select Settings>Control Panel and double-click ODBC.
On Windows 2000: From the Start menu select Settings>Control Panel and doubel-click Administrative Tools.  Then
double-click Data Sources (ODBC).

2.  

In the ODBC Data Source Administrator window select the System DSN tab. Highlight Reporter and select the Remove
button.

3.  

Select the Add... button to create a new Reporter data source.4.  

In the Create New Data Source dialog box select the SQL Server driver and the Finish button.5.  

Section 3, Part B: Configure SQL Server 2000 
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In the Create a New Data Source to SQL Server dialog, make sure that Reporter appears in the data source name box
and the server name appears in the Server box. Then select Next.

6.  

Select - With SQL Server authentication using a login ID and password entered by user.
Also check the box for Connect to SQL Server to obtain default settings. 
Enter the login ID and password that you used in the first section Install & Configure SQL Server 2000: Task 3  -
Configure the Database on SQL Server  2000.  Then select Next.

7.  

Section 3, Part B: Configure SQL Server 2000 
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Check Change the default database to, select Reporter, and click Next.8.  

Check Perform translation for character data and select Finish.9.  

Section 3, Part B: Configure SQL Server 2000 
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In the ODBC Microsoft SQL Server Setup dialog select the Test Data Source... button.10.  

Exit the SQL Server ODBC Data Source Test by clicking OK.11.  

Section 3, Part B: Configure SQL Server 2000 

file:///C|/FrontPage Webs/Content/hpovreports/Help/section03B.htm (11 of 14) [3/11/2002 12:33:19 PM]



Task 4  Configure Internet Services to use SQL as the Database

To start OpenView Internet Services Configuration Manager, select
Start>Programs>HP OpenView>internet services>Configuration Manager.

1.  

An error message is expected; click Yes to proceed.2.  
In the Database Login dialog box, enter the database User ID and Password that you used for the
system configuration.

3.  

Click OK.4.  
You will see the  Internet Services Startup status bars and then the main Configuration Manager window displays.5.  

Section 3, Part B: Configure SQL Server 2000 
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Start the following services:
HP Internet Services
Reporter Service
World Wide Web Pubshishing Service

6.  

Final Task Confirm that the Database is Set Up

From the Start menu, select Programs>Microsoft SQL  2000>Query Analyzer.1.  
Connect to your SQL Server using SQL Server authentication using the user name and password you created.2.  
In the SQL Server Query Analyzer dialog, select DB: reporter.3.  
Enter a query to verify the database connection.4.  
Then you can check the setup of the  Internet Services probes by entering the query:
select PROBENAME from IOPS_PROBE_DEFINITIONS

5.  

Click the green arrow or press F5.6.  

The following is an example of the results.7.  
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  Oracle Setup/Connections

Internet Services can be configured to work with Oracle as its database. The topics below
cover many versions of Oracle and also offer information on configuring the connection
to the Oracle listener.

 IMPORTANT: Do not run multiple copies of Internet Services as unexpected results
occur when more than one copy of Reporter attempts to write data to the configured 
database.

 IMPORTANT: Migration of data from your old database to the new Oracle database
is not supported for Internet Services (OVIS). And if OVIS is on the same system as hp
OpenView Reporter, attempting to migrate data to the new database with Reporter may
result in problems in OVIS.

Part A: Configure/edit the Oracle listener and tsnnames files■   

Part E: Configure Oracle 8.0.6 (Solaris) as the database■   

Part F: Configure Oracle 8.0.6 (HP-UX) as the database■   

Part G: Configure Oracle 8.1.6 or 8.1.7 (HP-UX or Solaris) as the database■   

Section 4: Configuring an 8.0.6, 8.1.6/7 Oracle database
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Oracle Setup/Connections
Part A: Edit templates to configure Oracle
listener.ora
& tnsnames files

Template 1 (listener.001) is for situations where no listener has been configured for Oracle. This template
allows you to insert text pertaining to the host system and directory where Oracle resides and use the file to
replace the existing listener file.

Template 1/A (tnsnames.001) is for configuring one Oracle database instance (for Reporter data). You can use
this template to insert text pertaining to the database instance you will use for the Reporter database.

Template 2   (listener.002) is for situations where a listener is already configured. This template allows you to
copy and paste settings relating to Reporter into your existing template.

Template 2/A (tnsnames.002) is for adding the configuration of an Oracle database instance for Reporter data
to the existing tnsnames.ora file that already is configured to recognize other Oracle database instances.

Template 1: Configuring the listener.ora file

The sample file below helps you edit the template included with Reporter (listener.001) for setting up a listener
for the Oracle database instance connection to Reporter. Before using the template:
(1) Replace the host name in two places 
(2) If necessary, change the ORACLE_HOME path (where Oracle resides).
(3) Rename the template to listener.ora. and copy it to the /etc directory for HP-UX or the
$ORACLE_HOME/network/admin directory for Solaris.

 

######################################################
# FILENAME: listener.ora
# DATE....: Jun 16 1999
# NETWORK.: openview
# NODE....: Server
# SERVICE.: LISTENER
# COMMENT.: For use with HP OpenView Reporter
######################################################

LISTENER =
   (ADDRESS_LIST =
      (ADDRESS=
      (PROTOCOL=IPC)
      (KEY= REPORTER)
      )

      (ADDRESS =
        (PROTOCOL = TCP)

Part A: Configure/edit Oracle listener and tnsnames files
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        (HOST = host_name) #### Insert your host name for <host_name>
        (PORT = 1521)
        (QUEUESIZE = 50) ##### Increased queue size for REPORTER
      )

      (ADDRESS =
         (PROTOCOL = TCP)
         (HOST = host_name) #### Insert your host name for <host_name>
         (PORT = 1526)
         (QUEUESIZE = 50) ##### Increased queue size for REPORTER
      )
   )

SID_LIST_LISTENER =
  (SID_LIST =
     (SID_DESC =
        (SID_NAME = REPORTER)
        (ORACLE_HOME= /opt/oracle/product/7.3.4)
        (ENVS='EPC_DISABLED=TRUE')
     )
  )

STARTUP_WAIT_TIME_LISTENER = 0
CONNECT_TIMEOUT_LISTENER = 30 ##### Increased timeout for REPORTER
LOG_DIRECTORY_LISTENER = /opt/oracle/product/7.3.4/network/log
LOG_FILE_LISTENER = listener
TRACE_LEVEL_LISTENER = OFF

Template 1A: Configuring the tnsnames.ora file,
using the template

The sample file below helps you edit the template included as tnsnames.001 for configuring one Oracle
database instance connection to Reporter. Before you can use the file:
(1) Replace the host name. 
(2) Rename the file to tnsnames.ora and copy into the /etc directory for HP-UX or the
$ORACLE_HOME/network/admin directory for Solaris.

####################
# FILENAME: tnsnames.ora
# DATE....: Jun 16 1999
# NETWORK.: openview
# NODE....: Server
# SERVICE.: LISTENER
# COMMENT.: For use with HP OpenView Reporter.
####################

RPT.world =
   (DESCRIPTION =
     (ADDRESS = (PROTOCOL= TCP)(Host= <host_name>)(Port= 1521))
     (CONNECT_DATA = (SID = REPORTER))
   )

Template 2: Editing the Existing listener.ora file,
copying from the template

The sample file below helps you edit the template included with Reporter (listener.002) to set up a listener for
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the database instance connection to Reporter. Before using the template: 
 (1) Replace the host name in two places. 
 (2) If necessary, modify the path where Oracle is located in two places.
 (3) Paste the REPORTER blocks and the "Increased queue size" line into 
      the appropriate places in your existing listener.ora file.  
 (4) Paste in or change the CONNECT_TIMEOUT_LISTENER line so that the
      timeout value is at least 30.

#########################
# FILENAME: listener.ora
# DATE....: Jun 16 1999
# NETWORK.: openview
# NODE....: Server
# SERVICE.: LISTENER
# COMMMENT: For use with HP OpenView Reporter
#########################

LISTENER =

  (ADDRESS_LIST =
    (ADDRESS=
           (PROTOCOL=IPC)
           (KEY= openview)
    )

##### Begin REPORTER block number 1 #######
    (ADDRESS=                             #
           (PROTOCOL=IPC)                 #
           (KEY= REPORTER)                #
    )                                     #
##### End REPORTER block number 1 #########

    (ADDRESS =
            (PROTOCOL = TCP)
            (HOST = <host_name>)
            (PORT = 1521)
            (QUEUESIZE = 50) #### Increased queue size for REPORTER
    )

##### Begin REPORTER block number 2 ########
    (ADDRESS =                             #
            (PROTOCOL = TCP)               #
            (HOST = <host_name>)           #
            (PORT = 1526)                  #
            (QUEUESIZE = 50)               #
    )                                      #
##### End REPORTER block number 2  #########

  )

SID_LIST_LISTENER =
  (SID_LIST =
      (SID_DESC =
         (SID_NAME = openview)
         (ORACLE_HOME= /opt/oracle/product/7.3.4)
      )
  )
##### Begin REPORTER block number 3 ##################
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      (SID_DESC =                                    #
         (SID_NAME = REPORTER)                       #
         (ORACLE_HOME= /opt/oracle/product/7.3.4)    #
         (ENVS='EPC_DISABLED=TRUE')                  #
       )                                             #
  )                                                  #
##### End REPORTER block number 3 ####################

)
STARTUP_WAIT_TIME_LISTENER = 0
CONNECT_TIMEOUT_LISTENER = 30 #### Increased timout for REPORTER
LOG_DIRECTORY_LISTENER = /opt/oracle/product/7.3.4/network/log
LOG_FILE_LISTENER = listener
TRACE_LEVEL_LISTENER = OFF

Template 2A: Editing the existing tnsnames.ora file, copying from the template

The sample file below helps you edit the template included as tnsnames.002 for use in changing your existing
tnsnames.ora file to recognize an Oracle database instance connection to Reporter. To use the template:

(1) Replace the host name in two places. 
(2) Paste the REPORTER blocks into the appropriate places in your existing tnsnames.ora file. 

########################
# FILENAME: tnsnames.ora
# DATE....: Jun 16 1999
# NETWORK.: openview
# NODE....: Server
# SERVICE.: LISTENER
# COMMENT.: For use with HP OpenView Reporter. 
#########################

ov_net =
(DESCRIPTION =
(ADDRESS = (PROTOCOL= TCP)(Host= <host_name>)(Port= 1521))
(CONNECT_DATA = (SID = openview))
)

##### Begin REPORTER block##################################
RPT.world =                                                #
(DESCRIPTION =                                             #
(ADDRESS = (PROTOCOL= TCP)(Host= <host_name>)(Port= 1521)) #
(CONNECT_DATA = (SID = REPORTER))                          #
)                                                          #
##### End REPORTER block ###################################
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 Oracle Setup/Connections
Part E: Configure Oracle 8.0.6 (Solaris) as the
Database

Set Up Oracle 8.0.6 on Solaris and Configure on Windows
Prerequisites: Check your Solaris system kernel parameters.   If they do not meet minimum requirements,
you will have to modify them and reboot your system. Internet Services requires 1400MB disk space in the
Oracle database. 
For other disk, system, and memory requirements, please check the "Features and Requirements" section of
the Oracle8 Installation Guide for Solaris. Oracle has specific recommendations regarding optimal database
installation and architecture. This document does not discuss all aspects of database installation and
administration. We suggest that you consult Oracle technical literature and qualified Oracle professionals to
achieve optimum database performance in your particular environment.

 IMPORTANT: Migration of data from your old database to the new Oracle database is not supported for
Internet Services (OVIS). And if OVIS is on the same system as hp OpenView Reporter, attempting to migrate
data to the new database with Reporter may result in problems in OVIS.

On the Solaris system (choose the appropriate procedure by clicking it):
Setup for new installations of Oracle 8
     (Task 1 — 5)

■   

Setup for existing installations of Oracle 8
    (plus Task 4 — 5)

■   

On the Windows system running Internet Services:
Configure Internet Services to use the Oracle database■   

Case Sensitivity: Some required entries in Windows are case-sensitive; so we recommend you
match instruction text exactly.

Setup for Oracle 8.0.6
The following tasks cover the preliminary setup of directories and user accounts as follows:

Task 1 Create Oracle Home Directories, user, and dba group
Task 2 Mount the CD & install Oracle software using the orainst program
Task 3 Create Reporter database objects
Task 4 Create Reporter Tablespace, User, and Privileges
Task 5 Configure Automatic Database Startup and Shutdown
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Task 1  Create Oracle home directories, user, and dba group

Before you begin, you need the following administrator privileges: root and dba privileges on the UNIX system
where you are using Oracle; administrator privileges on the Windows client where  Internet Services is installed.

You must be logged on as root or su1.  
Set umask as follows:
umask = 022

2.  

Create the the Oracle home directory by entering the following:
mkdir –p /opt/oracle/product/8.0.6

3.  

Create oracle user in /etc/passwd4.  
Run pwconv to create a password in /etc/shadow5.  
Create dba group and add oracle user in /etc/group6.  
Enter cd /opt7.  
Enter chown –R oracle:dba oracle8.  
The .profile needs to include PATH=$PATH:
Include environment variables from Task 2, step 3, below.

9.  

Task 2  Mount the CD & Install Oracle software using the orainst program

Put the CD in the CD-ROM drive.1.  
Log on as root.2.  
Set UNIX environment variables as follows:
ORACLE_OWNER – oracle

3.  

Modify permissions and ownership on /var/opt/oracle/oratab by entering the following:
chown oracle:dba /var/opt/oracle/oratab

4.  

Run /cdrom/oracle806/orainst/oratab.sh5.  
Log on as the oracle software owner (user created in Task 1 in Setup for new installations of Oracle
8.0.6).

6.  

Set UNIX environment variables as follows:
ORACLE_BASE – set to admin pathname default (/opt/oracle)
ORACLE_SID –  set to the database name you wish to create (REPORTER)
ORACLE_HOME – set to full pathname of the Oracle system home directory (/opt/oracle/product/8.0.6)
ORACLE_TERM – set to the appropriate value (hpterm, etc…)
PATH - needs to include $ORACLE_HOME/bin;/usr/xpg4/bin
SHLIB_PATH – set to $ORACLE_HOME/lib
ORACLE_OWNER – oracle

 Make sure the ORACLE_SID is set to REPORTER; otherwise the Internet Services tables will be put
in the wrong SID.

7.  

Enter the following to open the directory where the install program resides:
cd /cdrom/oracle806/orainst

8.  

Run the program either in character mode (which is used in this example) by entering:
./orainst /c or in Motif mode by entering: ./orainst /m

 Note: You must set your DISPLAY environment variable to <nodename>:0.0 before running the
Motif version of Oracle Installer.

9.  
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Select Default Install at the Install Type screen. Press OK to proceed.
The preamble.txt file appears, which contains information about changes to Oracle. At the
end of the text, you can select OK to display the README.FIRST file, which contains
information about the installation. Select OK to proceed.

■   

From the Installation Activity Choice screen - Select Install, Upgrade, or De-install
Software. Press OK to proceed.

■   

From the Installation Options screen - Select Install New Product – Do Not Create DB
Objects

■   

Confirm Environment variables ORACLE_HOME and ORACLE_BASE■   

Accept relinking default (no)■   

Verify Installation Options are correct■   

Select the following products from the Software Asset Manager Screen:■   

 Note:  If you are in character mode you can scroll to view all the products available.

Net8 8.0.6.0.0
Net8 Protocol Adapter (8.0.6.0.0)
  TCP/IP Protocol Adapter 8.0.6.0.0  
Oracle Intelligent Agent 8.0.6.0
Oracle Unix Installer 4.0.3.0
Oracle8 Enterprise (RDBMS)
PL/SQL 8.0.6.0.0
SQL*PLUS 8.0.6.0.0
   

 Note:  At the entry for Net8 Protocol Adapter (8.0.6.0.0), press Enter at the + (plus sign) to
select "TCP/IP Protocol Adapter 8.0.6.0.0"; toggle to a "-" and use the space bar to select "TCP/IP
Protocol Adapter."

Select Install or Tab to Install■   

Accept LSM default (no)■   

Exit the Oracle install program5.  

For new installations of Oracle skip to Task 3, Create REPORTER database objects

For existing installations of Oracle complete the step below.

Setup for existing installations of Oracle 8

Log on as the oracle software owner.  Verify that the following Solaris environment variables are set:

ORACLE_BASE – set to admin pathname default (/opt/oracle)
ORACLE_SID –  set to the database name you wish to create (REPORTER)
ORACLE_HOME – set to full pathname of the Oracle system home directory
ORACLE_TERM – set to the appropriate value (hpterm, etc…)
PATH - needs to include $ORACLE_HOME/bin;/usr/xpg4/bin
SHLIB_PATH – set to $ORACLE_HOME/lib
ORACLE_OWNER – oracle

 Make sure the ORACLE_SID is set to REPORTER; otherwise the Internet Services tables will be put
in the wrong SID.
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After you verify that the above environment variables are set as described above, you can complete Task 4,
Task 5, and configure the Windows system running Internet Services (a link to these instructions appears at the
end of the Task 5).

Task 3  Create REPORTER database objects

Edit the file $ORACLE_HOME/rdbms/install/rdbms/cnfg.orc  

 Note: you must do this step before creating objects.

Remove the comment (pound sign #) in the line:
#db_block_size = <blocksize> and change to:
db_block_size = 8192

1.  

Enter the following to change to the directory where the installation program resides:
cd $ORACLE_HOME/orainst
(if the directory does not exist, mount the CD as described in Task 2 and run /cdrom/oracle806/orainst)

2.  

To create database objects, run the installation program (in character mode) by entering
./orainst /c
and proceed as follows:

3.  

Select Default Install at the Install Type screen.  Press OK to proceed.
The preamble.txt file appears, which contains information about changes to Oracle. At the
end of the text, you can select OK to display the README.FIRST file, which contains
information about the installation. Select OK to proceed.

■   

Select Create/Upgrade Database Objects■   

Select Create Database Objects■   

Confirm Environment variables.■   

Verify Installation Options are correct■   

From the left pane, select  the following:■   

Net8 8.0.6.0.0
Net8 Protocol Adapter (8.0.6.0.0)
  TCP/IP Protocol Adapter 8.0.6.0.0  
Oracle Intelligent Agent 8.0.6.0           (recommended if available)
Oracle Unix Installer 4.0.3.0                 (recommended if available)
Oracle8 Enterprise (RDBMS)
PL/SQL 8.0.6.0.0
SQL*PLUS 8.0.6.0.0
Select Install.■   

Select Create Product DB Objects■   

Select /opt/oracle or the value of $ORACLE_BASE for the first mount point.

 Note: different mount allows you to specify different file systems for the database files.

■   

Select /opt/oracle or the value of $ORACLE_BASE for the second mount point.■   

Select /opt/oracle or the value of $ORACLE_BASE for the third mount point.■   

Select No for Demo tables.

 Note: Error during actions starting up the TNS listener message normally appears;

■   
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select Ignore.
Exit the Installation.■   

Run the program $ORACLE_HOME/bin/svrmgrl and enter the following commands to shut down the
REPORTER SID:

connect internal■   

shutdown immediate■   

exit■   

enter: ORACLE_SID=<next_Oracle_database_instance>
         export ORACLE_SID
(to shutdown each Oracle database instance; then run the svrmgrl program and
repeat these steps for all configured Oracle database instances.) 

■   

4.  

If you modified ORACLE_SID in step #4, reset it as follows:
ORACLE_SID=REPORTER
export ORACLE_SID

5.  

Log on as root
Verify that the following Solaris environment variables are set:

ORACLE_BASE – set to admin pathname default (/opt/oracle)
ORACLE_SID –  set to the database name you wish to create (REPORTER)
ORACLE_HOME – set to full pathname of the Oracle system home directory
ORACLE_TERM – set to the appropriate value (hpterm, etc…)
PATH - needs to include $ORACLE_HOME/bin;/usr/xpg4/bin
SHLIB_PATH – set to $ORACLE_HOME/lib
ORACLE_OWNER – oracle

 Make sure the ORACLE_SID is set to REPORTER; otherwise the Internet Services tables will
be put in the wrong SID.

6.  

Run $ORACLE_HOME/orainst/root.sh7.  
To access data from the Oracle database, you need to configure a listener by using the configuration
templates included with Internet Services. Follow instructions in either (A) if you do not have a listener
already configured or (B) if you have a listener configured.

A  Solaris with no existing Oracle listener configuration: From the Windows system in the \<install
dir>\newconfig\oracle\sun directory or from the Internet Services installation CD, copy the listener.001
and the tnsnames.001 files to the Solaris system $ORACLE_BASE/network/admin directory and
rename them to listener.ora and tnsnames.ora respectively. For help in editing these files, view the
examples linked here: listener.001 example; tnsnames.001 example. 

B  Solaris with existing Oracle listener configuration: From the Windows system in the \<install
dir>\newconfig\oracle\sun directory or from the Internet Services installation CD, copy the listener.002
and the tnsnames.002 files to the Solaris system $ORACLE_BASE/network/admin directory. Use the
templates to copy and paste the portions of the new listener configuration syntax into your existing
configuration files. For help in editing your existing files, view the examples linked here: listener.002
example; tnsnames.002 example

8.  

Log on as oracle.
Verify that the following Solaris environment variables are set:

ORACLE_BASE – set to admin pathname default (/opt/oracle)
ORACLE_SID –  set to the database name you wish to create (REPORTER)
ORACLE_HOME – set to full pathname of the Oracle system home directory
ORACLE_TERM – set to the appropriate value (hpterm, etc…)

9.  
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PATH - needs to include $ORACLE_HOME/bin;/usr/xpg4/bin
SHLIB_PATH – set to $ORACLE_HOME/lib
ORACLE_OWNER – oracle

 Make sure the ORACLE_SID is set to REPORTER; otherwise the Internet Services tables will
be put in the wrong SID.

Edit the file $ORACLE_BASE/admin/REPORTER/pfile/initREPORTER.ora by adding the following line
to the end of the file:

compatible = 8.0.6

10.  

Task 4  Create Reporter tablespace, user, and privileges*

Log on as root or su1.  
From the Windows Internet Services system \<install dir>\newconfig\oracle directory or from the Internet
Services installation CD,  copy the repconfig.sql file to your Solaris server directory
$ORACLE_BASE/admin/REPORTER/create/   

2.  

Enter: chown oracle:dba repconfig.sql3.  
Edit the file as follows (edits are highlighted) for size and performance considerations:4.  

 Note: In the example below maxsize is set to 900M where maxsize equals the maximum size
your file system can handle. You must replace /database/oradata with the path you have
established for your database data files. The data file names are only recommendations and can
be changed to conform to the standards at your site. Also the user and password are highlighted;
change as necessary.

 Note: For performance considerations Oracle recommends to place data
(tablespace REPORTER), index (tablespace RPT_INDEXES), and rollback segments
(tablespace RBS) on different disks if available.

create tablespace REPORTER datafile
'/database/oradata/REPORTER/rptdb01.dbf' SIZE 200M,
'/database/oradata/REPORTER/rptdb02.dbf' SIZE 200M
autoextend on next 20M maxsize 900M
default storage (
initial 8192k
next 8192k
pctincrease 0
);
create tablespace RPT_INDEXES datafile
'/database/oradata/REPORTER/rptidx01.dbf' size 300M
autoextend on next 20M maxsize 500M
default storage (
initial 8192k
next 8192k
pctincrease 0
);
alter tablespace SYSTEM add datafile
'/database/oradata/REPORTER/sys02.dbf' size 20M;
alter tablespace RBS add datafile
'/database/oradata/REPORTER/rbs02.dbf' size 50M;
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alter tablespace TEMP add datafile
'/database/oradata/REPORTER/tmp02.dbf' SIZE 20M;
create user openview identified by openview default tablespace REPORTER;
grant create session, create table, create any index, create sequence, create trigger, unlimited
tablespace to openview;
Log on as the oracle software owner.5.  
Set UNIX environment variables as follows:
ORACLE_BASE – set to admin pathname default (/opt/oracle)
ORACLE_SID –  set to the database name you wish to create (REPORTER)
ORACLE_HOME – set to full pathname of the Oracle system home directory
ORACLE_TERM – set to the appropriate value (hpterm, etc…)
PATH - needs to include $ORACLE_HOME/bin;/usr/xpg4/bin
SHLIB_PATH – set to $ORACLE_HOME/lib
ORACLE_OWNER – oracle

 Make sure the ORACLE_SID is set to REPORTER; otherwise the Internet Services tables will be put
in the wrong SID.

6.  

Run the $ORACLE_HOME/bin/svrmgrl program and enter the commands: 
connect internal
startup

7.  

Enter the following SQL statement:

@$ORACLE_BASE/admin/REPORTER/create/repconfig.sql

8.  

Enter the following command to exit: Exit9.  
Enter the following command to start the SQL listener: $ORACLE_HOME/bin/lsnrctl start10.  

Task 5  Configure Automatic Database Startup and Shutdown

The following procedure installs a script which invokes dbstart to start up all Oracle database instances, with
entries in the oratab file which have a "Y" as the startup flag.

 Warning! If your database administrator already has the startup procedure in place, you should skip this
step.

 Warning! If the If the OVO (OpenView) database is installed on same Oracle server, you must modify its
oratab entry to change the startup flag from "Y" to "N" since it is restarted by a different facility. For example,
change openview:$ORACLE_HOME:Y to openview:$ORACLE_HOME:N.

Log on as root.1.  
Mount the Internet Services Installation CD.2.  
Change to the CDROM directory /<cdrom>/oracle/sun.3.  
Enter ./postinstall to execute the script4.  

 Note: If you do not have access to the  Internet Services installation CD, you may copy files postinstall,
reporacle, and repcnfg from the  Internet Services Windows system directory:\<install
dir>\newconfig\oracle\sun to /tmp. Change permissions on the /tmp/postinstall file to 755, change to the /tmp
directory, and enter ./postinstall to execute the script.

Now you are ready to Configure Internet Services to use the Oracle database.
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Configure the Database on the Internet Services System

This section covers the installation of the software that allows the Windows system, on which Internet Services
runs, to connect to the Solaris system, from which the Oracle database is accessed.

Task 1  Install Oracle Client software

To begin, you need the following Oracle product: Oracle® Client Software, version 8.0.6, for Windows. You also
need administrator privileges on the Windows client where Internet Services is installed

At your Windows system, insert the CD and select Begin Installation in the dialog box that appears. 1.  
In the introductory dialog boxes that appear, (a) select the appropriate language, (b) enter the installation
settings for company name, and (c) accept or enter the directory to install software (c:\ORANT is the
default).

2.  

Accept Oracle8 Client as the type of installation to perform.3.  
Accept Database Administrator as the primary function you will be performing.4.  
Select whether to access the documentation on the CD (recommended) or to store on your hard drive.5.  
Click OK upon completion of the installation.
The system displays the Windows directory (for example, \WINNT35\) and path to the current list of
programs available from the Start menu, among them Oracle for Windows.

6.  

 Steps 7-10 install an Oracle ODBC driver patch. These steps may not be necessary if you
already have a patch equivalent to or later than 8.0.6. In this case, the procedure below will warn
you that you already have a more current version installed.
To install the Oracle ODBC patch:
Run Oracle installer (default location:c:\orant\bin\orainst.exe).

7.  

Choose the From button.8.  
Insert the Reporter CD and select \Support\oracle\win32\install\Nt.prd, then choose OK.9.  
Select Oracle8 ODBC driver and click install button.10.  
Exit the installer.11.  

 Important: You must reboot your system now.12.  

Task 2  Configure the Net8 connection to the reporter database

After you complete the installation of the Oracle client software on the Windows system running Internet
Services, on that same system complete the following steps:

From the Start/Programs menu, select Oracle for Windows NT and Oracle Net8 Easy Config.1.  
Click Yes to Warning dialog that appears to continue. Select the check box to prevent this warning from
appearing again.

2.  

Accept Add New Service, enter RPT in the New Service Name text box, and click Next.3.  
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Accept TCP/IP as the protocol to be used and click Next.4.  
In the TCP/IP Protocol Host Name text box enter the fully qualified host name for
<Solaris_database_server_name>
Enter the standard port number of 1521 and click Next.

5.  

The information appears as follows with your specific Host Name substituted:
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Enter REPORTER as the database SID and select Next
Important: the database SID "REPORTER" must be all uppercase to match the Oracle

SID name entered in the host configuration.

6.  

Click the Test Service button7.  
In the Test Connection dialog enter the database Username openview (or the user name
that you previously chose), the Password that you plan to use in the Internet Services,
select the Test button. Verify the test connection is successful and select the Done button.

8.  

In the Oracle Net8 Easy Config dialog box, click Next, then Finish.9.  

Task 3  Verify the Net8 connection to the REPORTER database

After you complete the Net8 configuration, perform the following steps to verify that you can contact the
database from your Windows system:

From the Start/Programs menu, select Oracle for Windows NT and SQL Plus 8.0.1.  
In the Log On dialog box, enter the database User Name and Password that you used for the UNIX
system configuration in Task 5, step 4 (openview) .

2.  
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Select the OK button. A good response would be similar to:

Connected to:
Oracle8 Enterprise Edition Release 8.0.6.0.0 - Production
With the Partitioning and Objects options
PL/SQL Release 8.0.6.0.0 - Production

SQL>

3.  

If you get error messages, you have an error in the connection from the Windows system to the Oracle 
database.

4.  

At the SQL> prompt, enter the command:
select TABLESPACE_NAME, STATUS from user_tablespaces;

You should see all the tablespace names displayed below.

TABLESPACE_NAME STATUS
------------------------------ ---------
SYSTEM ONLINE
RBS ONLINE
TEMP ONLINE
TOOLS ONLINE
USERS ONLINE
REPORTER ONLINE
RPT_INDEXES

7 rows selected.

If you successfully connected but do not see these tables, check with the database administrator for
Oracle on the host system.

5.  

From the File menu select Exit.6.  

Task 4  Configure the ODBC data source in the Windows Control Panel

After you have configured SQL*Net on the Windows system running Internet Services, you must configure the
ODBC data source.
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On the Windows system where Internet Services is (or will be) installed, complete the following steps:
Stop the following services:
HP Internet Services
Reporter Service
World Wide Web Pubshishing Service

1.  

Select Control Panel from the Windows Start/Settings menu.2.  
Double-click ODBC in the Control Panel window .3.  
Select the System DSN tabbed page.4.  
Choose Reporter with the default database driver and remove it.5.  
Choose the Add… button and highlight Oracle ODBC driver and select Finish.6.  
In the dialog box as appears below, enter the following:

Data Source Name:          Reporter 
Description:                      <Reporter database>
Service Name:                   RPT
User ID:                             (no entry necessary)

 Important: You must enter Reporter as the Data Source Name in mixed case (uppercase "R") to
match references to it in Internet Services executables.

7.  

Click OK.7.  
Close the ODBC Data Source Administrator window.8.  
Close the Control Panel window.9.  
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Task 5  Configure the Database in Internet Services

To start  Internet Services Configuration Manager, select
Start>Programs>HP OpenView>internet services>Configuration Manager.

1.  

An error message is expected; click Yes to proceed.2.  
In the Database Login dialog box, enter the database User Name and Password that you used for the
UNIX system configuration in Task 4, step 4 (username: openview; password: openview).

3.  

Click OK4.  
You will see the  Internet Services Startup status bars and then the main Configuration Manager window
displays.

5.  

Be sure the following services have been started:
HP Internet Services
Reporter Service
World Wide Web Pubshishing Service

6.  
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 Oracle Setup/Connections
Part F: Configure Oracle 8.0.6 (HP-UX) as the
Database

Set Up Oracle 8.0.6 on HP-UX and Configure on NT
Prerequisites: Check your HP-UX system kernel parameters.   If they do not meet minimum requirements,
you will have to modify them and reboot your system. Internet Services requires 1400MB disk space in the
Oracle database. 
For other disk, system, and memory requirements, please check the "Features and Requirements" section of
the Oracle8 Installation Guide for HP-UX. Oracle has specific recommendations regarding optimal database
installation and architecture. This document does not discuss all aspects of database installation and
administration. We suggest that you consult Oracle technical literature and qualified Oracle professionals to
achieve optimum database performance in your particular environment.

  IMPORTANT: Migration of data from your old database to the new Oracle database is not supported for
Internet Services (OVIS). And if OVIS is on the same system as hp OpenView Reporter, attempting to migrate
data to the new database with Reporter may result in problems in OVIS.

On the UNIX system (choose the appropriate procedure by clicking it):
Setup for new installations of Oracle 8
     (Task 1 — 6)

■   

Setup for existing installations of Oracle 8
    (Task 4 — 6)

■   

On the Windows system running Internet Services:
Configure Internet Services to use the Oracle database■   

Case Sensitivity: Some required entries in Windows are case-sensitive; so we recommend you
match instruction text exactly.

Setup for new installations of Oracle 8.0.6
The following tasks cover the preliminary setup of directories and user accounts as follows:

Task 1 Create Oracle Home Directories, user, and dba group
Task 2 Mount the CD
Task 3 Install Oracle software using the orainst program
Task 4 Create Reporter database objects
Task 5  Create Reporter Tablespace, User, and Privileges
Task 6 Configure Automatic Database Startup and Shutdown
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Task 1  Create Oracle home directories, user, and dba group

Before you begin, you need the following administrator privileges: root and dba privileges on the UNIX system
where you are using Oracle; administrator privileges on the Windows client where Internet Services is installed.

You must be logged on as root or su1.  
Set umask as follows:
umask = 022

2.  

Create the the Oracle home directory by entering the following:
mkdir –p /opt/oracle/product/8.0.6

3.  

Create dba group and add oracle user in /etc/group4.  
Create oracle user in /etc/passwd5.  
Enter cd /opt6.  
Enter chown –R oracle:dba oracle7.  
Modify permissions and ownership on /etc/oratab by entering the following:
chown oracle:dba /etc/oratab

8.  

Task 2  Mount the CD
Enter: /usr/sbin/pfs_mountd &  (Note:pfs creates the correct format to read the CD)1.  
Enter: /usr/sbin/pfsd &2.  
Use a system editor to add as follows:
/etc/pfs_fstab

Syntax:
<device_file> <mount_point> <filesystem_type> <translation_method>

<device_file> = CD-ROM device file
<mount_point> = mount point
<filesystem_type> = CD-ROM to be mounted is in IS09660 format  
<translation_method> = Rockridge extension

For example:

/dev/dsk/c5t2d0 /SD_CDROM pfs-rrip xlat=unix 0 0

3.  

Insert the CD into the CD-ROM and mount the device as follows:
/usr/sbin/pfs_mount /SD_CDROM

4.  

Change directories to /SD_CDROM where you can see a lower-case listing of the directories and files on
the CD-ROM. The mounted CD should appear as another read-only file system.

5.  

Exit the superuser account as follows: # exit.6.  

Task 3  Install Oracle software using the orainst program
Log on as the oracle software owner (user created in Task 1 in Setup for new installations of Oracle
8.0.6).

1.  
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Set UNIX environment variables as follows:
ORACLE_BASE – set to admin pathname default (/opt/oracle)
ORACLE_SID –  set to the database name you wish to create (REPORTER)
ORACLE_HOME – set to full pathname of the Oracle system home directory (/opt/oracle/product/8.0.6)
ORACLE_TERM – set to the appropriate value (hpterm, etc…)
PATH - needs to include $ORACLE_HOME/bin
SHLIB_PATH – set to $ORACLE_HOME/lib

 Make sure the ORACLE_SID is set to REPORTER; otherwise the Reporter tables will be put in the
wrong SID.

2.  

Enter the following to open the directory where the install program resides:
cd /<cdrom>/orainst

3.  

Run /<cdrom>/orainst/oratab.sh either in character mode (which is used in this example) by entering:
./orainst /c or in Motif mode by entering: ./orainst /m

 Note: You must set your DISPLAY environment variable to <nodename>:0.0 before running the
Motif version of Oracle Installer.

4.  

Select Default Install at the Install Type screen. Press OK.
The preamble.txt file appears, which contains information about changes to Oracle. At the
end the text, you can select OK to display the README.FIRST file, which contains
information about the installation. Select OK to proceed.

■   

From the Installation Activity Choice screen - Select Install, Upgrade, or De-install
Software

■   

From the Installation Options screen - Select Install New Product – Do Not Create DB
Objects

■   

Confirm Environment variables ORACLE_HOME and ORACLE_BASE■   

Accept relinking default (no)■   

Verify Installation Options are correct■   

Select the following products from the Software Asset Manager Screen:■   

 Note:  If you are in character mode you can scroll to view all the products available.

Net8 8.0.6.0.0
Net8 Protocol Adapter (8.0.6.0.0)
  TCP/IP Protocol Adapter 8.0.6.0.0  
Oracle Intelligent Agent 8.0.6.0
Oracle Unix Installer 4.0.3.0
Oracle8 Enterprise (RDBMS)
PL/SQL 8.0.6.0.0
SQL*PLUS 8.0.6.0.0

 Note:  At the entry for Net8 Protocol Adapter (8.0.6.0.0), press Enter at the + (plus sign) to
select "TCP/IP Protocol Adapter 8.0.6.0.0"; toggle to a "-" and use the space bar to select "TCP/IP
Protocol Adapter."

Select Install or Tab to Install■   

Enter Unix DBA group name, default is dba (needs to match dba group created in Task 1,
step 6)

■   

Exit the Oracle install program5.  

For new installations of Oracle skip to Task 4, Create REPORTER database objects
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For existing installations of Oracle complete the setup shown below.

Setup for existing installations of Oracle 8.0.6

Log on as the oracle software owner.  Verify that the following HP-UX environment variables are set:

ORACLE_SID - set to the database name you want to create (REPORTER)
ORACLE_BASE – set to admin pathname default (/opt/oracle)
ORACLE_HOME - set to full pathname of the Oracle system home directory (/opt/oracle/product/8.0.6)
ORACLE_TERM – set to the appropriate value (hpterm, etc…)
PATH - needs to include $ORACLE_HOME/bin
SHLIB_PATH – set to $ORACLE_HOME/lib

 Make sure the ORACLE_SID is set to REPORTER; otherwise the Internet Services tables will be put
in the wrong SID.

After you verify that the above environment variables are set as described above, you can complete Task 4,
Task 5, and configure the Windows system running Internet Services (a link to these instructions appears at the
end of the Task 5).

Task 4  Create REPORTER database objects
Edit the file $ORACLE_HOME/rdbms/install/rdbms/cnfg.orc  

 Note: you must do this step before creating objects.

Remove the comment (pound sign #) in the line:
#db_block_size = <blocksize> and change to:
db_block_size = 8192

1.  

Enter the following to change to the directory where the installation program resides:
cd $ORACLE_HOME/orainst
(if the directory does not exist, mount the CD as described in Task 2 and run /<cdrom>/orainst)

2.  

To create database objects, run the installation program (in character mode) by entering
./orainst /c
and proceed as follows:

3.  

Select Default Install at the Install Type screen
The preamble.txt file appears, which contains information about changes to Oracle. At the
end of the text, you can select OK to display the README.FIRST file, which contains
information about the installation. Select OK to proceed.

■   

Select Create/Upgrade Database Objects■   

Select Create Database Objects■   

Confirm Environment variables.■   

Verify Installation Options are correct■   

From the left pane, select  the following:■   

Net8 8.0.6.0
Net8 Protocol Adapter (8.0.6)
  TCP/IP Protocol Adapter 8.0.6.0.0  
Oracle Intelligent Agent 8.0.6.0           (recommended if available)
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Oracle Unix Installer 4.0.3.0               (recommended if available)
Oracle8 Enterprise (RDBMS)
PL/SQL 8.0.6.0.0
SQL*PLUS 8.0.6.0.0
Select Install.■   

Select Create Product DB Objects.■   

Select /opt/oracle or the value of $ORACLE_BASE for the first mount point.

 Note: different mount allows you to specify different file systems for the database.

■   

Select /opt/oracle or the value of $ORACLE_BASE for the second mount point.■   

Select /opt/oracle or the value of $ORACLE_BASE for the third mount point.■   

Exit the Installation.■   

Run the program $ORACLE_HOME/bin/svrmgrl and enter the following commands to shut down the
REPORTER SID:

connect internal■   

shutdown immediate■   

exit■   

enter: export ORACLE_SID=<next_Oracle_database_instance>
(to Reset to each Oracle database instance; then run the svrmgrl program and
repeat these steps for all Oracle database instances.) 

■   

4.  

If you modified ORACLE_SID in step #4, reset it as follows:
export ORACLE_SID=REPORTER

5.  

Log on as root
Verify that the following HP-UX environment variables are set:

ORACLE_SID - set to the database name you want to create (REPORTER)
ORACLE_BASE – set to admin pathname default (/opt/oracle)
ORACLE_HOME – set to full pathname of the Oracle system home directory
(/opt/oracle/product/8.0.6)
ORACLE_TERM – set to the appropriate value (hpterm, etc…)
PATH - needs to include $ORACLE_HOME/bin
SHLIB_PATH – set to $ORACLE_HOME/lib

 Make sure the ORACLE_SID is set to REPORTER; otherwise the Reporter tables will be put in
the wrong SID.

6.  

Run $ORACLE_HOME/orainst/root.sh7.  
To access data from the Oracle database, you need to configure a listener by using the configuration
templates included with Internet Services. Follow instructions in either (A) if you have a listener already
configured or (B) if you do not have a listener configured.

A  HP-UX with existing Oracle listener configuration: From the Windows system in the \<install
dir>\newconfig\oracle\hp-ux directory or from the Internet Services installation CD, copy the listener.002
and the tnsnames.002 files to the HP-UX system /etc/ directory. Use the templates to copy and paste the
portions of the new listener configuration syntax into your existing configuration files. For help in editing
your existing files, view the examples linked here: listener.002 example; tnsnames.002 example

B  HP-UX with no existing Oracle listener configuration: From the Windows system in the \<install
dir>\newconfig\oracle\hp-ux directory or from the Internet Services installation CD, copy the listener.001
and the tnsnames.001 files to the HP-UX system /etc/ directory and rename them to listener.ora and
tnsnames.ora respectively. For help in editing these files, view the examples linked here: listener.001
example; tnsnames.001 example. 

8.  

Part F: Configure Oracle 8.0.6 (HP-UX) as the database

file:///C|/FrontPage Webs/Content/hpovreports/Help/section04F.htm (5 of 13) [3/11/2002 12:33:21 PM]



Log on as oracle.
Verify that the following HP-UX environment variables are set:

ORACLE_SID - set to the database name you want to create (REPORTER)
ORACLE_BASE – set to admin pathname default (/opt/oracle)
ORACLE_HOME – set to full pathname of the Oracle system home directory
(/opt/oracle/product/8.0.6)
ORACLE_TERM – set to the appropriate value (hpterm, etc…)
PATH - needs to include $ORACLE_HOME/bin
SHLIB_PATH – set to $ORACLE_HOME/lib

 Make sure the ORACLE_SID is set to REPORTER; otherwise the Reporter tables will be put in
the wrong SID.

9.  

Edit the file $ORACLE_BASE/admin/REPORTER/pfile/initREPORTER.ora by adding the following line
to the end of the file:

compatible=8.0.6

10.  

Task 5  Create Reporter tablespace, user, and privileges*

Log on as root or su.1.  
From the Internet Services Windows system \<install idr>\newconfig\oracle directory or from the Internet
Services installation CD, copy the repconfig.sql file  to your HP-UX server directory
$ORACLE_BASE/admin/REPORTER/create/  

2.  

Enter: chown oracle:dba repconfig.sql3.  
Edit the file as follows (edits are highlighted) for size and performance considerations:

 Note: In the example below maxsize is set to 900M where maxsize equals the
maximum size your file system can handle. You must replace /database/oradata with the
path you have established for your database data files. The data file names are only
recommendations and can be changed to conform to the standards at your site. Also the
user and password are highlighted; change as necessary.

 Note: For performance considerations Oracle recommends to place data
(tablespace REPORTER), index (tablespace RPT_INDEXES), and rollback segments
(tablespace RBS) on different disks if available.

create tablespace REPORTER datafile
'/database/oradata/REPORTER/rptdb01.dbf' SIZE 200M,
'/database/oradata/REPORTER/rptdb02.dbf' SIZE 200M
autoextend on next 20M maxsize 900M
default storage (
initial 8192k
next 8192k
pctincrease 0
);
create tablespace RPT_INDEXES datafile
'/database/oradata/REPORTER/rptidx01.dbf' size 300M
autoextend on next 20M maxsize 500M
default storage (

4.  
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initial 8192k
next 8192k
pctincrease 0
);
alter tablespace SYSTEM add datafile
'/database/oradata/REPORTER/sys02.dbf' size 20M;
alter tablespace RBS add datafile
'/database/oradata/REPORTER/rbs02.dbf' size 50M;
alter tablespace TEMP add datafile
'/database/oradata/REPORTER/tmp02.dbf' SIZE 20M;
create user openview identified by openview default tablespace REPORTER;
grant create session, create table, create any index, create sequence, create trigger,
unlimited tablespace to openview;

Log on as the oracle software owner.5.  
Set UNIX environment variables as follows:
ORACLE_BASE – set to admin pathname default (/opt/oracle)
ORACLE_SID –  set to the database name you wish to create (REPORTER)
ORACLE_HOME – set to full pathname of the Oracle system home directory (/opt/oracle/product/8.0.6)
ORACLE_TERM – set to the appropriate value (hpterm, etc…)
PATH - needs to include $ORACLE_HOME/bin
SHLIB_PATH – set to $ORACLE_HOME/lib

 Make sure the ORACLE_SID is set to REPORTER; otherwise the Reporter tables will be put in the
wrong SID.

6.  

Run the $ORACLE_HOME/bin/svrmgrl program and enter the commands: 
connect internal
startup

7.  

Enter the following SQL statement:

@$ORACLE_BASE/admin/REPORTER/create/repconfig.sql

8.  

Enter the following command to exit: Exit9.  
Enter the following command to start the SQL listener: $ORACLE_HOME/bin/lsnrctl start10.  

Task 6  Configure Automatic Database Startup and Shutdown

The following procedure installs a script which invokes dbstart to start up all Oracle database instances, with
entries in the oratab file which have a "Y" as the startup flag.

 Warning! If your database administrator already has the startup procedure in place, you should skip this
step.

 Warning! If the OVO (openview) database is installed on same Oracle server, you must modify its oratab
entry to change the startup flag from "Y" to "N" since it is restarted by a different facility. For example, change
openview:$ORACLE_HOME:Y to openview:$ORACLE_HOME:N.

Note: Executing the following script to set up automatic database startup and shutdown assumes the Oracle
user name is oracle. If this is not the case, you will have to adjust the postinstall script accordingly.

Log on as root.1.  
Mount the Internet Services Installation CD.2.  
Change to the CDROM directory /cdrom/oracle/hp-ux.3.  
Enter ./postinstall to execute the script4.  
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 Note: If you do not have access to the Internet Services installation CD, you may copy files postinstall,
reporacle, and repcnfg from the Internet Services directory:\<install dir>\newconfig\oracle\hp-ux to /tmp.
Change permissions on the /tmp/postinstall file to 755, change to the /tmp directory, and enter ./postinstall to
execute the script.

Now you are ready to Configure Internet Services to use the Oracle database.

Configure the Database on the Windows System
This section covers the installation of the software that allows the Windows system, on which Internet Services
runs, to connect to the HP-UX system, from which the Oracle database is accessed.

Task 1  Install Oracle Client software & Reporter Patch

To begin, you need the following Oracle product: Oracle® Client Software, version 8.0.6, for Windows NT. You
also need administrator privileges on the Windows client where Reporter is installed

At your Windows system, insert the CD and select Begin Installation in the dialog box that appears. 1.  
In the introductory dialog boxes that appear, (a) select the appropriate language, (b) enter the installation
settings for company name, and (c) accept or enter the directory to install software (c:\ORANT is the
default).

2.  

Accept Oracle8 Client as the type of installation to perform.3.  
Accept Database Administrator as the primary function you will be performing.4.  
Select whether to access the documentation on the CD (recommended) or to store on your hard drive.5.  
Click OK upon completion of the installation.
The system displays the Windows directory (for example, \WINNT35\) and path to the current list of
programs available from the Start menu, among them Oracle for Windows.

6.  

Task 2 Configure the Net8 connection to the reporter database

After you complete the installation of the Oracle client software on the Windows system running Internet
Services, on that same system complete the following steps:

From the Start/Programs menu, select Oracle for Windows NT and Oracle Net8 Easy Config.1.  
Click Yes to Warning dialog that appears to continue. Select the check box to prevent this warning from
appearing again.

2.  

Accept Add New Service, enter RPT in the New Service Name text box, and click Next.3.  
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Accept TCP/IP as the protocol to be used and click Next.4.  
In the TCP/IP Host Name text box enter the fully qualified host name for
<HP-UX_database_server_name>
Enter the standard port number 1521 and click Next.

5.  

The information appears as follows with your specific Host Name substituted:
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Enter REPORTER as the database SID and select Next
 Important: the database SID "REPORTER" must be all uppercase to match the Oracle

SID name entered in the host configuration.

6.  

Click the Test Service button7.  
In the Test Connection dialog enter the database Username openview (or the user name
that you previously chose), the Password that you plan to use in Internet Services, select
the Test button. Verify the test connection is successful and select the Done button.

8.  

In the Oracle Net8 Easy Config dialog box, click Next, then Finish.

 

9.  

Task 3  Verify the Net8 connection to the REPORTER database

After you complete the Net8 configuration, perform the following steps to verify that you can contact the 
database from your Internet Services Windows system:

From the Start/Programs menu, select Oracle for Windows NT and SQL Plus 8.0.1.  
In the Log On dialog box, enter the database User Name and Password that you used for the UNIX
system configuration in Task 5, step 4 (openview identified by openview).

2.  
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Select the OK button. A good response would be similar to:

Connected to:
Oracle8 Enterprise Edition Release 8.0.6 - Production
With the Partitioning and Objects options
PL/SQL Release 8.0.6 - Production

SQL>

3.  

If you get error messages, you have an error in the connection from the Windows system to the Oracle
Reporter database.

4.  

At the SQL> prompt, enter the command:
select TABLESPACE_NAME, STATUS from user_tablespaces;

You should see all the tablespace names displayed below.

TABLESPACE_NAME STATUS
---------------------------------------
SYSTEM ONLINE
RBS ONLINE
TEMP ONLINE
TOOLS ONLINE
USERS ONLINE
REPORTER ONLINE
RPT_INDEXES

7 rows selected.

If you successfully connected but do not see these tables, check with the database administrator for
Oracle on the host system.

5.  

From the File menu select Exit.6.  

Task 4  Configure the ODBC data source in the Windows Control Panel

After you have configured SQL*Net on the Windows system running Internet Services, you must configure the
ODBC data source.

On the Windows system where Internet Services is (or will be) installed, complete the following steps:
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Stop the following services:
HP Internet Services
Reporter Service
World Wide Web Pubshishing Service

1.  

Select Control Panel from the Windows Start/Settings menu.2.  
Double-click ODBC in the Control Panel window .3.  
Select the System DSN tabbed page.4.  
Choose Reporter with the default database (MSDE or previously Microsoft Access) driver and remove it.5.  
Choose the Add… button and highlight Oracle ODBC driver and select Finish.6.  
In the dialog box as appears below, enter the following:

Data Source Name: Reporter 
Description: <Reporter database>
Service Name:  RPT
User ID:  (no entry necessary)

 Important: You must enter Reporter as the Data Source Name in mixed case (uppercase "R") to
match references to it in Reporter executables.

7.  

Click OK.8.  
Close the ODBC Data Source Administrator window.9.  
Close the Control Panel window.10.  
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To start  Internet Services Configuration Manager, select
Start>Programs>HP OpenView>internet services>Configuration Manager.

1.  

An error message is expected; click Yes to proceed.2.  
In the Database Login dialog box, enter the database User Name and Password that you used for the
UNIX system configuration in Task 4, step 4 (username: openview; password: openview).

3.  

Click OK4.  
You will see the  Internet Services Startup status bars and then the main Configuration Manager window
displays.

5.  

Be sure the following services have been started:
HP Internet Services
Reporter Service
World Wide Web Pubshishing Service

6.  
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 Oracle Setup/Connections
Part G: Configure Oracle 8.1.6 or 8.1.7 as the Database

Set Up Oracle 8.1.6 or 8.1.7 on HP-UX or Solaris and Configure on Windows
Prerequisites: Check your HP-UX or Solaris system kernel parameters and modify as necessary. For more information on
settings for Oracle 8.1.6/8.1.7 please refer to the Oracle 8i Installation Guide, chapter 2, Pre-Installation.

Internet Services requires 1400MB disk space in the Oracle database.

For other system, memory, and disk requirements, please check the "System Requirements" section of the Oracle 8i Installation
Guide included with the software distribution. Oracle has specific recommendations regarding optimal database installation and
architecture. This document does not discuss all aspects of database installation and administration. We suggest that you consult
Oracle technical literature and qualified Oracle professionals to achieve optimum database performance in your particular
environment.

 IMPORTANT: Migration of data from your old database to the new Oracle database is not supported for Internet Services
(OVIS). And if OVIS is on the same system as hp OpenView Reporter, attempting to migrate data to the new database with
Reporter may result in problems in OVIS.

On the UNIX or Solaris system (choose the appropriate procedure by clicking it):
Setup for new installations of Oracle 8.1.6 or 8.1.7
     (Task 1 — 6)

●   

Setup for existing installations of Oracle 8.1.6 or 8.1.7
    (Task 4 — 6)

●   

On the Windows system running Internet Services:
Configure Internet Services to use the Oracle database●   

Case Sensitivity: Some required entries in Windows are case-sensitive; so we recommend you match instruction text
exactly.

Setup for new installations of Oracle 8.1.6 or 8.1.7
Task 1 Create Oracle groups, user, and home directory
Task 2 Mount the CD
Task 3 Install Oracle software using the Oracle Universal Installer
Task 4 Create Reporter database objects
Task 5 Create Reporter Tablespace, User, and Privileges
Task 6 (optional) Configure Automatic Database Startup and Shutdown

Task 1  Create Oracle groups, user, and home directory

Before you begin, you need the following administrator privileges: root and dba privileges on the UNIX system where you are
using Oracle; administrator privileges on the Windows client where Internet Services is installed.

You must be logged on as root or su.1.  
For HP-UX: Use System Administration Manager (SAM) utility on HP-UX 11.0 to create UNIX group dba.
For Solaris: Use admintool or (groupadd utility) to create UNIX group dba.

2.  

For HP-UX: Use SAM utility to create UNIX group oinstall.
For Solaris: Use admintool or (groupadd utility) to create UNIX group oinstall.

3.  

For HP-UX: Use SAM utility to create UNIX user oracle.
For Solaris: Use admintool (or useradd utility) to create UNIX user oracle.

4.  
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a. Login name: oracle
b. Primary Group Name: oinstall
    Secondary Group Name: dba
c. Home directory: consistent with local standards
d. Login shell: consistent with local standards
Create Oracle Home mount point: mkdir –p /opt/oracle/product/8.1.6 or 8.1.75.  
Enter: cd /opt6.  
Enter chown –R oracle:oinstall oracle

 

7.  

Task 2  Mount the CD

For HP-UX:
Edit the /etc/pfs_fstab file (create it if it does not exist) to add the following line:
Syntax:
<device_file> <mount_point> <filesystem_type> <translation_method>
Definitions of the syntax above:
<device_file> = CD-ROM device file (discover with ioscan –nFC disk)
<mount_point> = path name of the mount point
<filesystem_type> = CD-ROM is in IS09660 format, Rockridge extension <translation_method> = unix
For example:
/dev/dsk/c1t2d0 /SD_CDROM pfs-rrip xlat=unix 0 0

1.  

Perform the following steps as the root user:
Enter: /usr/sbin/pfs_mountd &  (Note:pfs creates the correct format to read the CD)
Enter: /usr/sbin/pfsd &

2.  

Insert the CD into the CD-ROM and mount the device as follows:
/usr/sbin/pfs_mount /SD_CDROM

3.  

Change directories to /SD_CDROM where you can see a lower-case listing of the directories and files on the CD-ROM.
The mounted CD should appear as another read-only file system.

4.  

Leave the root user window available for executing a script during installation .5.  

For Solaris:

If you are using Volume Management software (available by default on Soalaris) the CD-ROM is mounted automatically to
/cdrom/oracle8i when you put it into the disk drive.

If you are not using the Volume Management software, you must mount the CD-ROM manually.
Place the Oracle 8i CD-ROM in the CD-ROM drive.1.  
Log in as the root or su user and create a CD-ROM mount point directory:
$ su root
# mkdir cdrom_mount_point_directory

2.  

Mount the CD-ROM drive on the mount point directory and exit:
# mount option device_name cdrom_mount_point_directory
# exit

3.  

Task 3  Install Oracle software using the Universal Oracle Installer
Log in to the oracle account
a. Verify umask command returns 022
b. Set umask 022 in .profile if needed

1.  

Set UNIX environment variables as follows: (add to .profile,or set manually)
DISPLAY=<workstation_name>:0.0 (<workstation_name> is computer where output from the Oracle Universal Installer
should be displayed)
ORACLE_BASE=/opt/oracle
ORACLE_HOME=/opt/oracle/product/8.1.6 or 8.1.7
ORACLE_SID=REPORTER
PATH includes $ORACLE_HOME/bin, /usr/bin, /etc, /usr/ccs/bin, /usr/local/bin

2.  

Change to the CD-ROM mount point:
For HP-UX: cd /SD_CDROM

3.  
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For Solaris: cd /cdrom_mount_point_directory (default= /cdrom/oracle8i)
Start the Installer: ./runInstaller
Note: The order for the following dialog boxes may vary according to your version of Oracle.
In the Welcome dialog, click Next.

4.  

In File Locations do not change the product Source...Path entry.,
The Oracle Home Destination...Path entry should display the value for ORACLE_HOME if previously set; click Next. The
illustration uses 8.1.6 for example; substitute 8.1.7 as appropriate.

5.  

For the UNIX Group Name enter oinstall and click Next.6.  
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If /var/opt/oracle does not exist or can not be edited by the oracle user, you are prompted to run
/tmp/Orainstall/orainstRoot.sh.
After running this script, click Retry to continue.

7.  

Under Available Products select Oracle8i Enterprise Edition 8.1.6.0.0 or 8.1.7.0.0, click Next.8.  
Under the Installation Types select Minimal installation; click Next.  9.  
In the Privileged Operating System Groups enter dba for the UNIX groups and click Next. 10.  
In Select Starter Database select No, and click Next.  11.  
In the Summary verify Space Requirements and select the Install button.
The Install dialog appears. 

12.  

In the Setup Privileges dialog run root.sh as instructed. 13.  
  When the "Install successful" message appears, click Next.
The Configuration Tools dialog appears. 

14.  

In the Net8 Configuration Assistant Welcome window click Next.15.  
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Select No to defer directory naming; click Next.  16.  
Select a Listener name—LISTENER is recommended—and click Next.  17.  
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Select TCP for the connection protocol, click Next.  18.  
Select the standard port number of 1521, click Next.  19.  
Select No for configuring another listener, click Next.  20.  
At "Listener configuration complete" message, click Next. 21.  
Select No for changing the naming methods, click Next.  22.  
At the "Net8 Configuration Complete" message, click Finish.23.  
In the End of Installation dialog click Exit.24.  

Task 4  Create Reporter database objects

Log in to the oracle account1.  
Update UNIX environment variables as follows: (add to .profile,or set manually)

DISPLAY=<workstation_name>:0.0
(<workstation_name> is computer where output from the Oracle products should be displayed)
ORACLE_BASE=/opt/oracle
ORACLE_HOME=/opt/oracle/product/8.1.6 or 8.1.7
ORACLE_SID=REPORTER
PATH includes $ORACLE_HOME/bin, /usr/bin, /etc, /usr/ccs/bin, /usr/local/bin

for HP-UX: SHLIB_PATH=$ORACLE_HOME/lib
for Solaris: LD_LIBRARY_PATH=$ORACLE_HOME/lib

for Oracle 8.1.6:
CLASSPATH=$ORACLE_BASE/JRE:$ORACLE_HOME/JRE:$ORACLE_HOME/jlib:
$ORACLE_HOME/network/jlib:$ORACLE_HOME/rdbms/jlib:$ORACLE_HOME/assistants/jlib
TNS_ADMIN=$ORACLE_HOME/network/admin

for Oracle 8.1.7:
CLASSPATH=$ORACLE_HOME/JRE/lib:$ORACLE_HOME/jlib:
$ORACLE_HOME/network/jlib:$ORACLE_HOME/rdbms/jlib:$ORACLE_HOME/assistants/jlib
TNS_ADMIN=$ORACLE_HOME/network/admin

2.  

Run the Database Configuration Assistant by entering dbassist3.  
In the startup window select Create a database, click Next. 4.  
Select Custom as the database type, click Next.5.  
Select Multipurpose as the type of application, click Next.6.  
Select number of concurrently connected users (suggest 40), click Next.7.  
Select Dedicated Server Mode, click Next.8.  
No options required for reporter; click Next.9.  
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Enter the Global Database Name (i.e. reporter<.domain.name> ) and SID (REPORTER), click Next.10.  

Review the Control File information, click Next.11.  
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Note: Oracle recommends multiplexing controls files on different disks to support database recoverability.
Size the SYSTEM tablespace at 100 MB; then click the Tools tab. 12.  
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Size the TOOLS tablespace at 10 MB, click User tab.13.  

Size the USERS tablespace at 1 MB; click Rollback tab.14.  
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Size the RBS tablespace at 65 MB; click Index tab.15.  

Size the INDX tablespace at 1 MB; click Temporary tab.16.  
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Size the TEMP tablespace at 25 MB; click Next.17.  

Review the Redo Log Files information; click Next. 18.  
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Review the logging parameter information; click Next.19.  
Review the SGA parameter information; click Next.20.  
Review the Trace File Directory information; click Next. 21.  
Select Create database now; click Finish.22.  

Task 5  Create Reporter tablespace, user, and privileges*

Log on as root or su.1.  
Create the file (below) and save as repconfig_ora8i.sql in the $ORACLE_BASE/admin/reporter/create/ directory:
(Internet Services includes a default version of this file and the edits you need to make are highlighted) :

Note: In the example below maxsize is set to 900M where maxsize equals the maximum size your file system can
handle. You must replace /database/oradata with the path you have established for your database data files. The data file
names are only recommendations and can be changed to conform to the standards at your site. Also the user and
password are highlighted; change as necessary.

Note: For performance considerations Oracle recommends to place data (tablespace REPORTER), index (tablespace
RPT_INDEXES), and rollback segments (tablespace RBS) on different disks if available.

create tablespace REPORTER datafile
'/database/oradata/reporter/rptdb01.dbf' SIZE 600M
autoextend on next 20M maxsize 900M
default storage (
initial 4096k
next 4096k
pctincrease 0
);
create tablespace RPT_INDEXES datafile
'/database/oradata/reporter/rptidx01.dbf' size 300M
autoextend on next 20M maxsize 500M
default storage (
initial 4096k
next 4096k
pctincrease 0
);
create user openview identified by openview
default tablespace REPORTER;
grant create session, create table, create view, create any index, create sequence, create procedure,
create trigger, unlimited tablespace to openview;

2.  

Log on as the oracle software owner.3.  
Make sure the ORACLE_SID is set to REPORTER; otherwise the Internet Services tables will be put in the wrong SID.4.  
Run the $ORACLE_HOME/bin/svrmgrl program and enter the following commands to start the database (the database
may have already been started)
connect internal
startup

5.  

Enter the following SQL statement:
@$ORACLE_BASE/admin/reporter/create/repconfig_ora8i.sql

6.  

Enter the following command to exit: Exit7.  
Enter the following commands to restart the SQL listener:
lsnrctl stop
lsnrctl start

8.  

Task 6 Configure Automatic Database Startup and Shutdown

You may optionally configure the database for automatic startup and shutdown. See the Oracle documentation for details on this
procedure.

 Warning! If your database administrator already has the startup procedure in place, you should skip this step.
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 Warning! If the OVO (also known as VantagePoint Operations or ITO) (openview) database is installed on
same Oracle server, you must modify its oratab entry to change the startup flag from "Y" to "N" since it is restarted
by a different facility. For example, change openview:$ORACLE_HOME:Y to openview:$ORACLE_HOME:N.

Now you are ready to configure Internet Services to use the Oracle database.

Configure Internet Services on the Windows System
This section covers the installation of the software that allows the Windows system, on which Internet Services runs, to connect
to the HP-UX or Solaris system, from which the Oracle database is accessed.

Task 1  Install Oracle Client software

To begin, you need the following Oracle product: Oracle8i Client, Release 2 (8.1.6) or Release 3 (8.1.7) for Windows (NT 4 or
2000). You also need administrator privileges on the Windows client where Internet Services is installed

At your Windows system, insert the Oracle8i Client CD and select Install/Deinstall Products in the dialog box that
appears. 

1.  

In the Oracle Universal Installer Welcome dialog click Next.2.  
In the File Locations dialog enter the Source and Destination file locations and click Next.3.  
In the Installation Types dialog select Administrator as the installation type and click Next.4.  
Verify information in the Summary dialog and click Install.5.  

The installation process starts the Configuration Tools dialog. The Net8 Configuration Assistant will optionally be run.

Task 2 Configure the Net8 connection to the Reporter database

After you complete the installation of the Oracle client software (the Net8 Configuration is optionally part of the client install and
dialog steps may differ slightly) on the Windows system running Internet Services, on that same system complete the following
steps:

From the Start/Programs menu, select Oracle><Oracle_Home>:Network Administration:Net8 Configuration
Assistant.

1.  

In the Welcome dialog select Local Net Service Name configuration and click Next.2.  
Select the Add radio button; click Next.3.  
In the Database Version dialog, select Oracle8i database or service (select the other option if connecting to a previous
Oracle version), click Next. 

4.  

In the Service Name dialog supply the global database name you entered in Task 4, step #10, of Configure reporter on
UNIX; (i.e. reporter.<domain.name>); click Next.  

5.  

At the Select Protocols dialog, select TCP, click Next.6.  
At the TCP/IP Protocol dialog, supply the Host Name and port number (typically 1521), click Next. 7.  
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At the Test dialog, select Yes, perform a test; click Next.  8.  
At the Connecting dialog, verify that the connection was successful (you may have to change the login credentials (i.e.,
openview/openview) for the test to succeed); click Next.

9.  
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At the Net Service Name dialog, supply a Net Service Name (suggested: RPT), and click Next.10.  

In the Another Net Service Name? dialog, select No, and click Next.11.  
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In the Done dialog, click Next, and then Finish.

Note: The Net Service Name (i.e., RPT) may have the network domain appended to its name, for example
RPT.<DOMAIN.NAME>. Rerun the Net8 assistant and select test to verify the actual, full Net Service Name.

12.  

Task 3 Verify the Net8 connection to the REPORTER database

After you complete the Net8 configuration, perform the following steps to verify that you can contact the database from your
Windows system:

From the Start/Programs menu, select Oracle <Oracle_Home>, Database Administration, and SQLPlus Worksheet.1.  
In the Oracle Enterprise Manager Login dialog, enter the database Username and Password that you used for the UNIX
system configuration in Task 5, step 2 (username: openview, password:openview). Enter the Service name
(RPT.<domain_name>)

2.  

Click the OK button.3.  
In the SQL*Plus Worksheet, enter the command:
select TABLESPACE_NAME, STATUS from user_tablespaces

The following tablespace names should be displayed:
TABLESPACE_NAME                 STATUS
--------------------------------------
SYSTEM                          ONLINE
TOOLS                           ONLINE
RBS                             ONLINE
TEMP                            ONLINE
USERS                           ONLINE
INDX                            ONLINE
REPORTER                        ONLINE
RPT_INDEXES                     ONLINE
8 rows selected.

4.  

If you cannot connect to the database, or do not see these tables, check with the Oracle database administrator for
the UNIX host system.
From the File menu select Exit.5.  

Task 4 Configure the ODBC data source in the Windows Control Panel

After you have configured Net8 on the Windows system running Internet Services, you must configure the ODBC data source.

On the Windows system where Internet Services is (or will be) installed, complete the following steps:
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Stop the following services:
HP Internet Services
Reporter Service
World Wide Web Pubshishing Service

1.  

Select Start>Settings>Control Panel.2.  
In the Control Panel window::
for Windows 2000 double-click Administrative Tools (Windows 2000), then
ODBC Data Sources.
for NT 4 double-click ODBC Data Sources.

3.  

Select the System DSN tabbed page.4.  
Choose Reporter with the default database driver and remove it.5.  
Select the Add… button and highlight Oracle ODBC Driver and select Finish.6.  
In the dialog box that appears, enter the following:

Data Source Name: Reporter 
Description: <your_description>
Service Name:  RPT.<domain_name>
User ID:  (no entry necessary)

 Important: You must enter Reporter as the Data Source Name in mixed case (uppercase "R") to match references to
it in Internet Services executables.

7.  

Task 5 Configure Internet Services to use the Database

To start  Internet Services Configuration Manager, select
Start>Programs>HP OpenView>internet services>Configuration Manager.

1.  

An error message is expected; click Yes to proceed.2.  
In the Database Login dialog box, enter the database User Name and Password that you used for the
UNIX system configuration in Task 4, step 4 (username: openview; password: openview).

3.  
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Click OK4.  
You will see the  Internet Services Startup status bars and then the main Configuration Manager window displays.5.  

Start the following services:
HP Internet Services
Reporter Service
World Wide Web Pubshishing Service

6.  
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